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1.  Introduction 
 

1.1 Add-on Module RF-TIMBER SANS 

The South African Standards SANS 10163-1 [1] and SANS 10163-2 [2] incorporate design provi-
sion for limit-states design (LSD) and allowable stress design (ASD). With the RFEM add-on 
module RF-TIMBER SANS from the company DLUBAL all users obtain a powerful tool for the de-
sign of timber structures modeled with member elements according to those Standards. 

RF-TIMBER SANS performs all cross-section resistance designs, stability analyses, and defor-
mation analyses provided by the standard. The stability analysis is carried out according to  
the equivalent member method or the second-order analysis. When the equivalent member 
method is applied, the program considers stability factors based on effective buckling lengths 
and effective lengths for lateral buckling. Second order analysis requires definition of imper-
fections in RFEM and calculates with unit stability factors for compression with buckling. In ad-
ditional to this, the fire resistance design is possible. 

In timber construction, the serviceability limit state is an important design. In this connection, 
selected load cases, load combinations, and allowed result combinations can be checked for 
limit deflection. The limit deformations are preset according to the Standard, and can be ad-
justed, if necessary.  In addition to this, it is possible to specify reference lengths and precam-
bers that will be considered accordingly in the design. 

If necessary, you can optimize standardized or parametric cross-sections and export them to 
RFEM. Separate design cases allow for a separate design of large systems or analysis of vari-
ants. 

RF-TIMBER SANS is one of the add-on modules integrated in the RFEM environment. Thus, the 
design-relevant input data is preset when you open the module. Subsequent to the design, 
you can use the graphical RFEM user interface to evaluate the results. Last but not least, you 
can document the checks from the analysis of internal forces to the design in the global 
printout report. 

We hope you will enjoy working with RF-TIMBER SANS. 

Your DLUBAL Team 
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1.2 RF-TIMBER SANS - Team 
The following people were involved in the development of RF-TIMBER SANS: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
Ing. Myroslava Petronyuk 

Dipl.-Ing. (FH) Gerhard Rehm 

Programming 
Ing. Tomáš Drtina 
Darya Shatalova 

Ing. Jiří Patrák 

Cross-section and material database 
Ing. Ph.D. Jan Rybín 
Mgr. Petr Oulehle 

Ing. Jiří Kubíček 
Peter Roth, Bc. 

Program design, dialog figures, icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. Myroslava Petronyuk  
Dipl.-Ing. (FH) Gerhard Rehm 

Ing. Ondřej Švorc 
Dipl.-Ing. (FH) Bastian Kuhn 

Localization, manual 
Ing. Fabio Borriello 
Ing. Dmitry Bystrov 
Eng.º Rafael Duarte 
Markéta Fišerová, Bc. 
Ing. Lara Freyer 
Ing. Alessandra Grosso, Ph.D. 
Ing. Ladislav Kábrt 
Eng.º Nilton Lopes 

Mgr. Ing. Hana Macková 
Ing. Téc. Ind. José Martínez 
Ing. Myroslava Petronyuk 
Mgr. Jagoda Podgórna 
Mgr. Petra Pokorná 
Chelsea Prokop, BSc Eng 
Ing. Marcela Svitáková 
Dipl.-Ing. (FH) Robert Vogl 

Technical support and quality management 
Dipl.-Ing. (BA) Markus Baumgärtel 
M.Sc. Sonja von Bloh 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 

Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Ulrich Lex 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Gerhard Rehm 
Dipl.-Ing. (FH) Lukas Sühnel 
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RFEM. The present manual focuses on typical fea-
tures of the RF-TIMBER SANS add-on module. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. In the text, the described buttons are given in square brackets, for example 
[View mode]. At the same time, they are pictured on the left. Expressions appearing in dialog 
boxes, windows, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you still cannot find what you are 
looking for, please check our website www.dlubal.com where you can go through our FAQ 
pages by selecting particular criteria. 

1.4 Starting RF-TIMBER SANS 
RFEM provides the following options to start the add-on module RF-TIMBER SANS. 

Menu 
To start the program in the RFEM menu bar, click 

Add-on Modules → Design - Timber → RF-TIMBER SANS. 

 

Figure 1.1: Menu: Add-on Modules → Design – Timber → RF-TIMBER 
SANS

http://www.dlubal.com/
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Navigator 
As an alternative, you can start the add-on module in the Data navigator by clicking 

Add-on Modules → RF-TIMBER SANS. 

 

Figure 1.2: Data navigator: Add-on Modules → RF-TIMBER SANS 

Panel 
If results from RF-TIMBER SANS are already available in the RFEM model, you can also open the 
design module in the panel: 

Set the relevant RF-TIMBER SANS design case in the load case list of the RFEM toolbar. Then 
click the [Show results] button to graphically display the design criterion on the members. 

When the results display is activated, the panel is available, too. Now you can click the button 
[RF-TIMBER SANS] in the panel to open the module. 

 

Figure 1.3: Panel button [RF-TIMBER SANS] 
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2.  Input Data 
When you have started the add-on module, a new window opens. In this window a Navigator  
is displayed on the left, managing the available windows that can be currently selected. The 
drop-down list above the navigator contains the design cases (see Chapter 7.1, page 63). 

The design relevant data is defined in several input windows. When you start RF-TIMBER SANS 
for the first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, and result combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a window, click the corresponding entry in the navigator. To set the previous or next 
input window, use the buttons shown on the left. You can also use the function keys to select 
the next [F2] or previous [F3]. 

To save the results, click [OK]. Thus, you exit RF-TIMBER SANS and return to the main program.  
To exit the module without saving the new data, click [Cancel]. 

2.1 General Data 
In the 1.1 General Data Window, you select the members, sets of members, and actions that 
you want to design. The tabs are managing the load cases, load combinations, and result 
combinations for the different designs. 

 
Figure 2.1: Window 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box: Then you can access the text boxes to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be cleared by clicking the [Delete] button. Alternatively, you can select the objects 
graphically in the RFEM work window after clicking []. 

When you design a set of members, the program determines the extreme values of the anal-
yses of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the results 
Windows 2.3 Designs by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 
Parts List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RFEM 
appears where you can specify the parameters of set of members. 

If beams are divided by nodes, it is necessary to verify them as a set of members. 

Design according to 

 
Figure 2.3: Design according to LSD or ASD 

The options of the list box control whether the analysis is carried out according to the provi-
sions of the Limit-States Design (LSD) or the Allowable Stress Design (ASD). 

Comment 

 
Figure 2.4: User-defined comment 

In this text box, you can enter user-defined notes. 
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2.1.1 Ultimate Limit State 

 
Figure 2.5: Window 1.1 General Data, tab Ultimate Limit State 

Existing Load Cases / Combinations 
This column lists all load cases, load combinations, and result combinations created in RFEM.  

To transfer selected entries to the Selected for Design list on the right, click []. Alternatively, 
you can double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common for 
Windows applications. 

Load cases highlighted in red, like LC 4 in Figure 2.5, cannot be designed. This happens when 
the load cases are defined without any load data or the load cases contain only imperfections. 
When you transfer the load cases, a corresponding warning appears. 

At the end of the list, several filter options are available. They will help you assign the entries 
sorted by load case, load combination, or action category. The buttons have the following 
functions: 

 
Selects all load cases in the list 

 
Inverts the selection of load cases 

Table 2.1: Buttons in the tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases, load combinations, and result combinations se-
lected for design. To remove selected entries from the list, click [] or double-click the entries. 
To transfer the entire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all contained load cases and load combinations. 

Result combinations should be selected for design only for dynamic combinations. For "usual" 
combinations, load combinations are recommended. 
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2.1.2 Serviceability Limit State 

 
Figure 2.6: Window 1.1 General Data, tab Serviceability Limit State 

Existing Load Cases and Combinations 
This section lists all load cases, load combinations, and result combinations created in RFEM. 

Selected for Design 
Load cases, load combinations, and result combinations can be added or removed (see Chap-
ter 2.1.1). 

The limit value of the deformation is controlled by the settings in the Details dialog box, tab 
Serviceability (see Figure 3.3, page 42) which you can call up by clicking the [Details] button. 

In the 1.11 Serviceability Data Window, the reference lengths decisive for the deformation 
check are managed (see Chapter 2.13, page 67). 
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2.1.3 Fire Resistance 

 
Figure 2.7: Window 1.1 General Data, tab Fire Resistance 

Existing Load Cases and Combinations 
All load cases, load combinations, and result combinations created in RFEM are listed here. 

Selected for Design 
Load cases, load combinations and allowed result combinations can be added or removed (see 
Chapter 2.1.1). 

The fire resistance design is performed by means of reduced cross-sections. The general speci-
fications for the fire resistance design are managed in the dialog boxes Standard (see Chapter 
2.1.4) and Details, tab Fire Resistance (see Figure 3.4, page 43). 
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2.1.4 Standard 
The drop-down lists in the 1.1 General Data Window allow you to select the method of design 
whose parameters are to be applied to the design. 

 
Figure 2.8: Selecting design method 

All preset parameters which are applied to the design are specified in the Standard dialog box. 

To check and, if necessary, adjust these parameters, you can use the [Standard] button in all 
input windows in order to open the Standard dialog box. It consists of three tabs. The content 
of the dialog box depends on the selected design method. 

Load Duration Factors 

 

Figure 2.9: Dialog box Standard, tab Load Duration Factors for LSD design method 
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Figure 2.10: Dialog box Standard, tab Load Duration Factors for ASD design method   

In the dialog box sections, you can check or, if necessary, modify the Load Duration Coefficients 
or the Self-Weight Load Effect Reduction. 

The buttons in the Standard dialog box are reserved for the following functions: 

 

 
Table 2.2: Buttons in the Standard dialog box  

Button Function 

 Resets the program's default settings 

 
Imports user-defined standard settings 

 
Saves the current settings as default 

 
Deletes a user-defined Standard 
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Other Factors 
In the second tab of the Standard dialog box, you find more factors significant for the design. 

 
Figure 2.11: Dialog box Standard, tab Other Factors for LSD design method 

 
Figure 2.12: Dialog box Standard, tab Other Factors for ASD design method 
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Used Standards 
The last tab informs you about the Standards according to which the design is performed. 

 
Figure 2.13: Dialog box Standard, tab Used Standards  
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2.2 Materials 

The window consists of two parts. In the upper part, all materials created in RFEM are listed. In 
the Material Properties section, the properties of the current material, that is, the table row cur-
rently selected in the upper section, are displayed. 

 
Figure 2.14: Window 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in 
Chapter 4.3 of the RFEM manual (Main Properties). The material properties required for design 
are stored in the global material library. These values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select in the mod-
ule's menu Settings → Units and Decimal Places (see Chapter 7.3, page 67). 

Material Description 
The materials defined in RFEM are preset, but it is always possible to modify them: To do this, 
click the material in column A. Then click [] or press function key [F7] to open the material list. 

 
Figure 2.15: List of materials for ASD design method 

According to the design concept of SANS 10163-1 [1] and SANS 10163-2 [2], the list includes 
only materials of the South African Standard. 
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When you have imported a material, the design relevant Material Properties are updated. 

It is not possible to edit the material properties in the RF-TIMBER SANS module. 

Material Library 
Many materials are available in the library. To open the corresponding dialog box, select 

Edit → Material Library 

or click the button shown on the left. 

 
Figure 2.16: Dialog box Material Library 

In the Filter section, SANS is preset as Standard. Select the material quality that you want to use 
for the design in the Material to Select list. You can check the corresponding properties in the 
dialog section below. 

Click [OK] or press [↵] to transfer the selected material to Window 1.2 of the module RF-TIMBER 
SANS. 

Chapter 4.3 of the RFEM manual describes how materials can be filtered, added, or rearranged. 
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Material Properties 
The lower section of Window 1.2 contains the specified strength values for bending, tension 
parallel, tension perpendicular, compression parallel, compression perpendicular, shear, as 
well as modulus of elasticity for design of compression members. 

The compressive stress parallel to the grain, pcy, in material database is defined for the short col-
umns, which slenderness ratio is le/b ≤ 10. For columns with slenderness ratio le/b > 10 the com-
pressive stress parallel is calculated in the module according to [2] Chapter 7.4.1. 

The design values of the material strengths are to be determined with the modification factors. 
The factors can be modified in the Standard Settings dialog box (see Figure 2.10 and Figure 2.12). 
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2.3 Cross-Sections 

This window manages the cross-sections used for design. In addition, the window allows you 
to specify optimization parameters. 

 
Figure 2.17: Window 1.3 Cross-Sections 

Cross-Section Description 
The cross-sections defined in RFEM are preset, as well as the assigned material numbers. 

The design is possible for parametric rectangular and circular timber cross-sections and for 
standardized rectangular timber cross-sections according to the South African Standard SANS 
10163. 

To modify a cross-section, click the entry in column B selecting this field. Click [Cross-section 
Library] or [...] in the field or press function key [F7] to open the cross-section table of the cur-
rent input field (see the following two figures). 

In those dialog boxes, you can select a different cross-section or a different cross-section table. 
To select a different cross-section category, click [Back to cross-section library] to access the 
general cross-section library. 

Chapter 4.13 of the RFEM manual describes how cross-sections can be selected from the library. 
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Figure 2.18: Parametric timber cross-sections of the library 

 
Figure 2.19: Standardized timber cross-sections of the library 

The new cross-section description can be entered in the text box directly. If the database con-
tains an entry, RF-TIMBER SANS imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections specified in RF-TIMBER SANS are different from the ones used in RFEM, both 
cross-sections are displayed in the graphic in the right part of the window. The designs will be 
performed with the internal forces from RFEM for the cross-section selected in RF-TIMBER SANS. 
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Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
zation. By means of the displayed design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overloaded and thus undersized. 

Optimize 
You can optimize all rectangular and circular cross-sections: For the RFEM internal forces, the 
program searches the cross-section that comes as close as possible to a user-defined maximum 
utilization ratio. You can define the maximum ratio in the Other tab of the Details dialog box, 
(see Figure 3.5, page 44). 

If you want to optimize a cross-section, open the drop-down list in column D or E. Recommen-
dations for optimizing cross-sections can be found in Chapter 7.2 on page 64. 

Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

Info About Cross-Section 
In the Info About Cross-Section dialog box, you can check the cross-section properties and 
stress points. 

 
Figure 2.20: Dialog box Info About Cross-Section 

The right part of the dialog box shows the currently selected cross-section. 
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The buttons below the graphic have the following functions: 

 

 

Table 2.3: Buttons of cross-section graphic 

Click [Details] to call up specific information on the stress points (distances to center of gravity, 
statical moments of area, etc.). 

 
Figure 2.21: Dialog box Stress Points 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the numbers of stress points 

 
Shows the details of the stress points (see Figure 2.21) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 

 
Prints the cross-section values and cross-section graphic 
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2.4 Load Duration 
In Window 1.4, you define the load duration to consider factors reflecting the different load 
duration for all chosen load cases. 

 
Figure 2.22: Window 1.4 Load Duration  

Loading 
All load cases selected in the 1.1 General Data Window are listed here.  

Description 
The load case descriptions make the classification easier. 

Load Type 
This table column shows the load cases' types of action as defined while creating them in RFEM. 
They are the basis for the presetting in the subsequent table column. 

Load Effect 
The load effect defines the type of loading which the construction is loaded. In this column 
you can define the load effect of each load case: By clicking the cell in column C, the [] button 
becomes available. If there is a load case you do not want to take into account when determin-
ing the load duration factor, you can choose Negligible load effect in the list box. 

Load Duration 
Loads must be assigned to classes of load duration. The classification of actions is specified in 
[1] Table 3 or in [1] Table 7, for example. The load duration can be changed as follows: Click the 
cell in column D to select the box, and then use the [] button to open the list. 

The classes of the load effect and load duration are required for the determination of the load 
duration factors, Υm1 and d1 (for LSD method), and the factors, k1 and d1 (for ASD method). The 
default values of the load duration coefficients Cd, Cf  or CI can be checked and, if necessary, ad-
justed in the Standard dialog box (see Figure 2.9 and Figure 2.10, page 13 f.). 
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2.5 Moisture Content and Treatment - 
Members (LSD) 

The determination of moisture makes it possible to assign the material factor for moisture con-
tent for ultimate limit state design, Υm4, and for serviceability limit state design, d2. The columns 
A or B are only available if you have set the relevant entries in the Ultimate Limit State or Service-
ability Limit State tab of Window 1.1 General Data. 

 
Figure 2.23: Window 1.5 Moisture Content and Treatment - Members (LSD) 

The default values of the factors Υm4, d2 and Υm5 can be checked and, if necessary, adjusted in 
the Standard dialog box (see Figure 2.11, page 15). 

By default, pressure treatment is not used. If you want to define treatment to the selected 
members, use the [] button. 

Below the Settings table, you find the Set input for members No. check box. If it is selected, the 
settings entered afterward will be applied to the selected or even to All members. Members 
can be selected by entering the member number or by selecting them graphically with the [] 
button. This option is useful when you want to assign identical conditions to several members. 
Please note that settings that have been already defined cannot be changed subsequently by 
using this function. 

The other buttons below the table have the following functions: 

Button Function 

 Exports table into MS Excel or OpenOffice Calc 

 
Directs to the row of member graphically selected in RFEM work window 

 Switches into RFEM work window 

Table 2.4: Buttons in Window 1.5 Moisture Content and Fabrication Quality - Members 
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2.6 Moisture Content and Treatment - 
Sets of Members (LSD) 

This window is only available if one or more sets of members have been selected in Window 
1.1 General Data. 

 
Figure 2.24: Window 1.6 Moisture Content and Treatment – Set of Members (LSD) 

The concept of this window is similar to the one in the previous Window 1.6 Moisture Content 
and Treatment - Members. In this window, you can assign the moisture content and the fabrica-
tion quality of the wood to each set of members. 
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2.7 Moisture Content and Fabrication Quality - 
Members (ASD) 

This window is similar to the 1.5 Moisture Content and Treatment - Members Window above (see 
Figure 2.23). 

In this window it is possible to assign the moisture content factors for the Ultimate Limit State 
Design, k5, and for the Serviceability Limit State Design, d2. 

 
Figure 2.25: Window 1.5 Moisture Content and Fabrication Quality - Members (ASD) 

The default values of the factors k5, d2 and k4 can be checked and, if necessary, adjusted in the 
Standard dialog box (see Figure 2.12, page 15). 

When a component is complying with a SANS Standard, you can apply the modification factor 
for Fabrication Quality, k4 in column C. 
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2.8 Moisture Content and Fabrication Quality - 
Sets of Members (ASD) 

 
Figure 2.26: Window 1.6 Moisture Content and Fabrication Quality - Sets of Members (ASD) 

The concept of this window is similar to the one in the previous Window 1.5 Moisture Content 
and Fabrication Quality - Members window. In this window, you can assign the moisture con-
tent and the fabrication quality of the wood to each set of members. 

2.9 Effective Lengths - Members 
The appearance of the window depends on whether the stability analysis is carried out accord-
ing to the equivalent member method or according to second-order analysis. You can specify 
that method in the Stability tab of the Details dialog box (see Figure 3.2, page 41). The follow-
ing description refers to the equivalent member default method. For that, the parameters of 
buckling and lateral-torsional buckling must be defined. 

If the stability analysis is deactivated in the Stability tab of the Details dialog box, Window 1.7 is 
not shown. 

The window consists of two parts. The table in the upper part provides summarized information 
about the factors for the lengths of buckling and lateral-torsional buckling as well as the equiva-
lent member lengths of the members to be designed. The effective lengths defined in RFEM are 
preset. In the Settings section, you can see further information about the member whose row is 
selected in the upper section. 

Click [] to select a member graphically and to show its row. 

Changes can be made in the table as well as in the Settings tree. 
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Figure 2.27: Window 1.7 Effective Lengths - Members (LSD) for equivalent member method 

 
Figure 2.28: Window 1.7 Effective Lengths - Members (ASD) for equivalent member method 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically in the work window after clicking [...]. This button is enabled when you click in the 
text box (see figure above). 
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The Settings tree manages the following parameters: 

• Cross-section 

• Length (actual length of the member) 

• Buckling Possible (corresponds to column A) 

• Buckling About Axis y Possible (corresponds to columns B to D) 

• Buckling About Axis z Possible (corresponds to columns E to G) 

• Lateral-Torsional Buckling Possible (corresponds to columns H to K) 

In this table, you can specify for the currently selected member whether to carry out a buckling 
or a lateral-torsional buckling analysis. In addition to this, you can adjust the Effective Length 
Factor for the respective lengths. When a coefficient is modified, the equivalent member 
length is adjusted automatically, and vice versa. 

You can also define the buckling length of a member in a dialog box. To open it, click the 
button shown on the left. It is located on the right below the upper table of the window. 

 
Figure 2.29: Dialog box Select Effective Length Factor for LSD method 

For each direction, you can select one of the buckling modes (theoretical and recommended 
values of buckling length factors according to [1] Table B.1). 
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Figure 2.30: Dialog box Select Effective Length Factor for ASD method 

If an eigenvalue analysis was carried out in the add-on module RF-STABILITY, you can also se-
lect a Buckling mode to determine the coefficient. 

Buckling Possible 
A stability analysis for flexural buckling and lateral-torsional buckling requires the ability of 
members to resist compressive forces. Therefore, members for which such resistance is not 
possible because of the member type (for example tension members, elastic foundations, rigid 
couplings) are excluded from design in the first place. The corresponding rows appear dimmed 
and a note is displayed in the Comment column. 

The Buckling Possible check boxes in table column A and in the Settings tree enable you to clas-
sify specific members as compression members or, alternatively, to exclude them from the 
stability analysis.. 

Buckling About Axis y / Buckling About Axis z 
With the check boxes in the Possible table columns, you decide whether a member is suscepti-
ble to buckling about the y-axis and/or z-axis. Those axes represent the local member axes, 
with axis y being the "major" and axis z the "minor" member axis. The buckling length factors 
Key and Kez for buckling about the major or the minor axis can be selected freely.  

You can check the position of the member axes in the cross-section graphic in Window 1.3 
Cross-Sections (see Figure 2.17, page 20). To access the RFEM work window, click [View mode]. 
In the work window, you can display the local member axes by using the member's shortcut 
menu or the Display navigator. 
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Figure 2.31: Selecting the member axis systems in the Display navigator of RFEM  

If buckling is possible about one or even both member axes, you can enter the effective length 
factors as well as the effective lengths in the columns C and D respectively as F and G. The same 
is possible in the Settings table. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a Le text box. 

When you define the effective length factor Ke, the program determines the effective length Le 
by multiplying the member length L by this effective length factor. The text boxes for Ke and Le 
are interactive. 

Lateral-Torsional Buckling Possible 
Table column H controls whether a lateral-torsional buckling analysis is to be carried out or not. 

Define Le (LSD) 
The member lengths are preset in column I as equivalent member lengths relevant for lateral-
torsional buckling. When you set the options manually in the list box, you can specify the 
length for lateral-torsional buckling Le in column J. You can also define it graphically after click-
ing […] as the distance of the lateral supports. Thus, you can adjust the boundary conditions of 
a structural component if it consists of several members between the supports. 

In column K, the coefficient for calculating the moment resistance of a laterally unsupported 
beam, ω2, is indicated. By default it is preset to 1.0, but it can be adjusted if necessary. 

Define Le (ASD) 
The definition of Le is similar to the LSD method. In addition, it is possible to define lateral-
torsional buckling length in accordance with [2] Table 11. A new dialog is opened in which you 
can select the effective length according to the loading conditions (see Figure 2.32). 
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Figure 2.32: Dialog box Effective Length for Bending Members Acc. to Table 11 

Below the Settings table, you find the Set inputs for members No. check box. If selected, the set-
tings entered afterward will be applied to the selected or to All members. Members can be se-
lected by typing the member number or by selecting them graphically using the [] button. 
This option is useful when you want to assign the same boundary conditions to several mem-
bers. Please note that already defined settings cannot be changed subsequently with this 
function. 

Comment 
In the last table column, you can enter you own comments for each member to describe, for 
example, the selected equivalent member lengths. 
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2.10 Effective Lengths - Sets of Members 
This window is only available if one or more sets of members have been selected in Window 
1.1 General Data. Additionally, the stability check must have been activated in the dialog box 
Details, tab Stability (see Figure 3.2, page 41). 

 
Figure 2.33: Window 1.8 Effective Lengths - Sets of Members (LSD) 

 
Figure 2.34: Window 1.8 Effective Lengths - Sets of members (ASD) for equivalent member method 
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The concept of this window is similar to the one in the previous Window 1.7 Effective Lengths - 
Members. In this window, you can enter the effective lengths for buckling as well as for lateral-
torsional buckling as described in Chapter 2.9. They determine the boundary conditions of the 
entire set of members which is to be treated as an equivalent member. 

2.11 Additional Design Parameters - Members 
This window allows you to allocate the load sharing factor, Υm2 (LSD) or k2 (ASD), to each mem-
ber. This factor depends on the interaction between members in the model. By clicking the [] 
button in column A, the Yes option (according to [1] Chapter 13.1.2.2 or Chapter 6.3.4) can be 
selected.  

You can define in column B whether the member is beam or truss, which controls the structure 
type factor, Υm3 (LSD) or k3 (ASD). 

By default, the program assigns No load sharing factor and the Beam structure type factor. The 
factors can be checked and, if necessary, adjusted in the Standard dialog box (see Figure 2.11 
and Figure 2.12, page 15Figure ). 

 
Figure 2.35: Window 1.9 Additional Design Parameters 

The Set input for members No. check box below the table enables you to assign the settings to 
selected or All members (see Chapter 2.7 and Chapter 2.9). 
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2.12 Additional Design Parameters - Sets of 
Members 

This window manages the additional design parameters of sets of members. It is displayed 
when you have selected one or more sets of members in Window 1.1 General Data. 

 
Figure 2.36: Window 1.10 Additional Design Parameters - Sets of Members 

The set-up of this window is similar to the one of the previous window (see Chapter 2.11). 
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2.13 Serviceability Data 
This input window controls several settings for the serviceability limit state design. It is only 
available if you have set the relevant entries in the Serviceability Limit State tab of Window 1.1 
General Data (see Chapter 2.1.2, page 11). 

 
Figure 2.37: Window 1.11 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RFEM work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

Table column E defines the governing Direction for the deformation analysis. You can select 
the directions of the local member axes y and z and the resultant direction R. 

In column F and G, you can allow for some Precamber  wc,y  and wc,z.. 

The Beam Type is of crucial importance for the correct application of limit deformations. Col-
umn H controls whether is a beam or cantilever and which ends is not supported. 

The settings in the Serviceability tab of the Details dialog box decide whether the deformations 
are related to the undeformed initial model or to the shifted ends of members or sets of mem-
bers (see Figure 3.3, page 42). 
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2.14 Fire Resistance - Members 
This window manages the different fire resistance parameters. It is available when you have set 
the relevant entries in the Fire Resistance tab of Window 1.1 General Data (see Chapter 2.1.3, 
page 12). 

 
Figure 2.38: Window 1.12 Fire Resistance - Members 

Table column A contains the members that are to be taken into account for the fire resistance 
design. Click […] to graphically select the members in the RFEM work window. 

 In column B you specify if there is an Exposure to Fire on Four Sides. If the cross-section is not 
exposed to fire on all sides, clear the selection of the check box. Thus, the following columns 
become available in which you can specify the sides that are exposed to fire. The ideal remain-
ing cross-section is then computed with those assumptions. 

The general parameters of the fire resistance analysis are managed in the Details dialog box, 
tab Fire Resistance Design (see Figure 3.4, page 43). 
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2.15 Fire Resistance - Sets of Members 
This window manages the fire resistance parameters of sets of members. It is displayed when 
you have selected one or more sets of members in Window 1.1 General Data and when you 
have allocated specific load cases or combinations in the Fire Resistance tab of that window. 

 
Figure 2.39: Window 1.13 Fire Resistance - Set of Members 

The set-up of this window is similar to the one of the previous window (see Chapter 2.14). Here 
you can define the sides of the cross-section that are exposed to fire for the relevant set of 
members. 
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3.  Calculation 
 

3.1 Detail Settings 
Before you start the calculation, it is recommended to check the design details. You can open 
the corresponding dialog box in all windows of the add-on module by clicking [Details]. 

The Details dialog box contains the following tabs: 

• Resistance 

• Stability 

• Serviceability 

• Fire Resistance 

• Other 

3.1.1 Resistance 

 
Figure 3.1: Dialog box Details, tab Resistance 

Consideration of Connections 
Often, zones near member connections show weakening of the cross-section. It is possible to 
take into account this effect by a Reduction of limit tension stresses. 

The numbers of the relevant nodes can be entered manually or selected graphically by clicking 
the [] button. 
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Equivalent member method: 
Specifying method of analysis in RFEM 

The Connection length defines the zone on the member where reduced stresses are considered. 
In the text box below, enter the allowable stress ratio for Inside connections in percent. If re-
quired, you can also change the maximum ratio for Outside connections of the connection zone. 

Limit Value for Special Cases 
Torsion design is not specified in SANS 10163. It is possible to ignore shear stresses due to tor-
sion if a user-defined ratio of the torsional shear resistance is not exceeded (default: 5 %). 

If the limit is exceeded, a note appears in the result window. This limit setting is not part of the 
Standard [1] or [2][1]. Changing the limit is the responsibility of the user. It is also possible to 
completely Ignore torsion. 

3.1.2 Stability 

 
Figure 3.2: Dialog box Details, tab Stability 

The Check stability check box controls whether to run, in addition the cross-section design, a 
stability analysis. If you clear the check box, the input Windows 1.7 and 1.8 will not be shown. 

The equivalent member method uses the internal forces determined in RFEM. In this method, 
make sure that the Geometrically linear static analysis has been set (the default setting is 
the 2nd order analysis). When you perform the stability analysis according to the equivalent 
member method, the effective lengths of the members and sets of members subject to com-
pression or compression and bending must be specified in Windows 1.7 and 1.8. 
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If the bearing capacity of the model is significantly affected by its deformations, we recom-
mend selecting a calculation according to the second order theory. This approach additionally 
requires the definition of imperfections in RFEM and their consideration for the load combina-
tions. The flexural buckling analysis is carried out during the calculation of the load combina-
tions in RFEM. 

The lateral-torsional buckling design must also be carried out for second order calculations. 
Thus, the lateral-torsional buckling lengths of members or sets of members are to be specified 
in Windows 1.7 or 1.8 Effective Lengths manually. In this way, we can make sure that the lateral-
torsional buckling analysis is performed with the appropriate factors (for example 1.0). 

3.1.3 Serviceability  

 
Figure 3.3: Dialog box Details, tab Serviceability 

Deformations Related to 
The option fields control whether the maximum deformations are related to the shifted ends 
of members or sets of members (connection line between start and end nodes of the de-
formed system) or to the undeformed initial system. As a rule, the deformations are to be 
checked relative to the displacements in the entire structural system. 

Serviceability Limits (Deflections) 
In this tab, it is possible to change the allowable deflection for the serviceability limit state de-
sign if the default values L/300 (for inner span) and Lc/150 (for cantilever) are not appropriate. 
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3.1.4 Fire Resistance 

 
Figure 3.4: Dialog box Details, tab Fire Resistance (ASD) 

The Exposure time can be defined by specifying the duration of the fire in the text box. 

In [2] for fire design, the grade stresses of members are used by default. If required, it is possi-
ble to analyze the fire resistance with the characteristic stresses by selecting the check box Use 
failure stress of 2.22 times basic stress (characteristic stress is equal to 2.22 times of grade stress). 

 Additionally, some standard-specific parameters that are significant for the fire resistance de-
sign can be set in the Standard dialog box (see Figure 2.11 or Figure 2.12, page 15). 
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3.1.5 Other 

 
Figure 3.5: Dialog box Details, tab Other 

Cross-Section Optimization 
The optimization is targeted on the maximum design ratio of 100 %. If necessary, you can 
specify a different limit value in this text box. 

Check of Member Slenderness 
In the three text boxes, you can specify the limit values of the member slendernesses. You can 
define the ratios separately for members with Flexure (CS), for members with Tension (L/ri), and 
for members with Compression (Lei/ri). 

The limit values are compared to the real member slendernesses in Window 3.3. This window  
is available after the calculation (see Chapter 4.8, page 52) if the corresponding check box is se-
lected in the Display Result Windows dialog box section. 

Display Result Windows 
In this dialog section, you can select the results tables including parts lists that you want to 
display in the output windows. The windows are described in Chapter 4 Results. 

The 3.3 Member Slendernesses Window is inactive by default. 
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3.2 Start Calculation 
To start the calculation, click the [Calculation] button which is available in all input windows of 
the RF-TIMBER SANS add-on module. 

RF-TIMBER SANS searches for the results of the load cases, load and result combinations that 
are to be designed. If they cannot be found, the program starts the RFEM calculation to deter-
mine the design relevant internal forces. 

You can also start the calculation in the user interface of RFEM: In the dialog box To Calculate 
(menu Calculate → To Calculate), design cases of the add-on modules are listed like load cases 
and load combinations. 

 
Figure 3.6: Dialog box To Calculate 

If the RF-TIMBER SANS cases are missing in the Not Calculated section, select All or Add-on 
Modules in the drop-down list below the section. 

To transfer the selected RF-TIMBER SANS cases to the list on the right, use the [] button.  
Click [OK] to start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the RF-TIMBER SANS 
design case in the toolbar list, and then click [Show Results]. 

 
Figure 3.7: Direct calculation of a RF-TIMBER SANS design case in RFEM 

Subsequently, you can observe the design process in a separate dialog box. 
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4.  Results 
Window 2.1 Design by Load Case is displayed immediately after the calculation. 

 
Figure 4.1: Results window with designs and intermediate values 

The designs are shown in the results Windows 2.1 through 2.5, sorted by different criteria. 

Windows 3.1 and 3.2 list the governing internal forces. Window 3.3 informs you about the 
member slendernesses. The last two results Windows 4.1 and 4.2 show the parts lists sorted by 
member and set of members. 

Every window can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input window, use the buttons shown on the left. You can also use the func-
tion keys to select the next [F2] or previous [F3] window. 

To save the results, click [OK]. You exit RF-TIMBER SANS and return to the main program. 

Chapter 4 Results describes the different results windows one by one. Evaluating and checking 
results is described in Chapter 5 Evaluation of Results starting on page 51. 
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4.1 Design by Load Case 
The upper part of the window provides a summary, sorted by load cases, load combinations, 
and result combinations of the governing designs. Furthermore, the list is divided in Ultimate 
Limit State Design, Serviceability Limit State Design and Fire Resistance Design results. 

The lower part gives detailed information on the cross-section properties, analyzed internal 
forces, and design parameters for the load case selected above. 

 
Figure 4.2: Window 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load and result combinations used for 
the design. 

Member No. 
This column shows the number of the member that bears the maximum design ratio of every 
designed loading. 

Location x 
The column shows the x-location at which the maximum design ratio of each member occurs. 
For the table output, the program uses the following member locations x: 

• Start and end node 

• Division points according to possibly defined member division (see RFEM table 1.16) 

• Member division according to specification for member results (RFEM dialog box  
Calculation parameters, tab Global Calculation Parameters) 

• Extreme values of internal forces 

Design 
Columns D and E show the design conditions according to [1]or [2]. 

The lengths of the colored bars represent the respective utilizations. 
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Design According to Formula 
This column lists the equations of the Standard by which the designs have been performed. 

Load Duration 
In column G, the load duration classes as defined in Window 1.4 are listed for load cases (see 
Chapter 2.4, page 24). 

4.2 Design by Cross-Section 

 
Figure 4.3: Window 2.2 Design by Cross-Section 

This window lists the maximum ratios of all members and actions selected for design, sorted 
by cross-sections. 

The results are sorted by cross-section design, stability design, serviceability limit state design 
and fire resistance design. 
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4.3 Design by Set of Members 

 
Figure 4.4: Window 2.3 Design by Set of Members 

This results window is displayed if you have selected at least one set of members for the design. 
The window lists the maximum ratios sorted by set of members. 

The Member No. column shows the number of the one member within the set of members that 
bears the maximum ratio for the individual design criteria. 

The output by sets of members clearly presents the design for an entire structural group (for 
example a chord). 
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4.4 Design by Member 

 
Figure 4.5: Window 2.4 Design by Member 

This results window presents the maximum ratios for the individual designs sorted by member 
number. The columns are described in detail in Chapter 4.1 on page 47. 

4.5 Design by x-Location 

 
Figure 4.6: Window 2.5 Design by x-Location 
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This results window lists the maxima for each member at all x-locations resulting from the divi-
sion points in RFEM: 

• Start and end node 

• Division points according to possibly defined member division (see RFEM table 1.16) 

• Member division according to specification for member results (RFEM dialog box  
Calculation Parameters, tab Global Calculation Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Window 3.1 Governing Internal Forces by Member 

For each member, this window displays the governing internal forces, that is, those internal 
forces that result in the maximum utilization in each design. 

Location x 
At this x-location of the member, the respective maximum design ratio occurs. 

Load Case 
This column displays the number of the load case, the load combination, or result combination 
whose internal forces result in the maximum design ratios. 

Forces / Moments 
For each member, these columns displays the axial and shear forces as well as the torsional 
and bending moments producing maximum design ratios in the respective cross-section, sta-
bility, serviceability limit state and fire resistance designs. 

Design According to Formula 
The final column provides information on the types of design and the equations by which the 
designs according to [1] or [2] have been performed. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members 

This window contains the individual internal forces that result in the maximum ratios of the 
design for each set of members. 

4.8 Member Slendernesses 

 
Figure 4.9: Window 3.3 Member Slendernesses 
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This results window is displayed when you have selected the respective check box in the Other 
tab of the Details dialog box (see Figure 3.5, page 44). 

The table lists all effective slendernesses ratios of the designed members for both principal ax-
es directions. They are determined depending on the load type. At the end of the list, you find 
a comparison with the limit values that have been defined in the Details dialog box, tab Other 
(see Figure 3.5, page 44). 

This window is displayed only for information. No design of the slendernesses is carried out. 

4.9 Parts List by Member 
RF-TIMBER SANS provides a summary of all cross-sections that are included in the design case. 

 
Figure 4.10: Window 4.1 Parts List by Member 

By default, the list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Details dialog box, tab Other (see Figure 3.5, 
page 44). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 

Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 
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Surface Area 
For each part, the program indicates the surface area relative to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in Windows 1.3 
and 2.1 through 2.5 (see Figure 2.20, page 22). 

Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight of the cross-section is relative to the length of one meter.  

Weight 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Weight 
The final column indicates the total weight of each part. 

Sum 
At the bottom of the list, you find a sum of the values in the columns B, D, E, F, and I. The last 
cell of the column Total Weight gives information about the total amount of timber required. 

4.10 Parts List by Set of Members  

 
Figure 4.11: Window 4.2 Parts List by Set of Members 

The last results window is displayed if you have selected at least one set of members for de-
sign. It summarizes an entire structural group (for example a chord) in a parts list. 

Details on the various columns can be found in the previous chapter. If there are different 
cross-sections in the set of members, the program averages the surface area, the volume, and 
the cross-section weight. 
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5.  Evaluation of Results 
You can evaluate the design results in different ways. 

 
Figure 5.1: Buttons for evaluation of results 

The buttons below the upper results tables are very useful for the evaluation of the results. 

Button Description Function 

 
Ultimate Limit State 
Designs 

Shows or hides the results of the ultimate limit 
state design 

 
Serviceability Limit 
State Designs 

Shows or hides the results of the serviceability 
limit state design 

 
Fire Resistance De-
sign 

Shows or hides the results of the fire resistance 
design 

 Show Color Bars 
Shows or hides the colored relation scales in the 
results windows 

 Filter Options 
Displays only rows with ratios greater than the 
filter criterion set in text box: design ratios > 1, 
maximum or user-defined limit 

 Result Diagrams 
Opens the Window Result Diagram on Member 
 Chapter 5.2, page 58 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 Chapter 7.4.3, page 68 

 Member Selection 
Allows you to graphically select a member to 
display its results in the table 

 View Mode 
Jumps to the RFEM work window to change the 
view 

Table 5.1: Buttons in Windows 2.1 through 2.5 
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5.1 Results in RFEM Model 
To evaluate the design results, you can also use the RFEM work window. 

RFEM background graphic and view mode 
The RFEM work window in the background is useful for finding the position of a particular 
member in the model: The member selected in the RF-TIMBER SANS results window is high-
lighted in the selection color in the background graphic. Furthermore, an arrow indicates the 
member's x-location that is displayed in the selected window row. 

 
Figure 5.2: Indication of the member and the current Location x in the RFEM model 

If you cannot improve the display by moving the RF-TIMBER SANS module window, click 
[Jump to Graphic] to activate the View Mode: Thus, you hide the module window so that you 
can modify the display in the RFEM user interface. In the view mode, you can use the functions 
of the View menu, for example zooming, moving, or rotating the display. The pointer remains 
visible. 

Click [Back] to return to the add-on module RF-TIMBER SANS. 

RFEM work window 
You can also graphically check the design ratios in the RFEM model: Click [Graphics] to exit the 
design module. In the RFEM work window, the design ratios are now displayed like the internal 
forces of a load case. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RFEM. To display the result values, click the [Show Values] toolbar 
button to the right. 

The RFEM tables are of no relevance for the evaluation of design results. 

The design cases can be set by means of the list in the RFEM menu bar. 
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The graphical representation of the results can be set in the Display navigator by clicking  
Results → Members. The ratios are shown Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), 
the color panel becomes available. It provides common control functions that are described in 
detail in the RFEM manual, Chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

The graphics of the design results can be transferred to the printout report (see Chapter 6.2, 
page 61). 

To return to the add-on module, click the [RF-TIMBER SANS] panel button.  
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5.2 Result Diagrams 
You can also evaluate the member results graphically in the result diagram. 

To do this, select the member (or set of members) in the RF-TIMBER SANS results window by 
clicking in the table row of the member. Then open the Result Diagram on Member dialog box 
by clicking the button shown on the left. The button is located below the upper results table 
(see Figure 5.1, page 55). 

To display the result diagrams, select the command from the RFEM menu 

Results → Result Diagrams for Selected Members 

or use the button in the RFEM toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to select the relevant RF-TIMBER SANS design case. 

This dialog box Result Diagram on Member is described in the RFEM manual, Chapter 9.5. 
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5.3 Filter for Results 
The RF-TIMBER SANS results windows allow you to sort the results by various criteria. In addi-
tion, you can use the filter options for graphical evaluation of the results as described in Chap-
ter 9.9 of the RFEM manual. 

You can use the Visibility option also for RF-TIMBER SANS (see RFEM manual, Chapter 9.9.1) to 
filter the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RFEM work window, which you can 
open by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is 
not, select 

View → Control Panel (Color scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RFEM manual, Chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Color spectrum). As this register is not available for the 
two-colored results display, you have to use the Display navigator and set the display options 
Colored With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the Display Hidden Result Diagram option in the Display navigator (Results → Mem-
bers), you can display all design ratio diagrams that are not covered by the color spectrum. 
Those diagrams are represented by dotted lines. 
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. The function is described in detail in the RFEM 
manual, Chapter 9.9.3. 

 

Figure 5.7: Member filter for ratios of diagonals 

Unlike the partial view function (Visibilities), the graphic displays the entire model. The figure 
above shows the ratios in the diagonals of a truss girder. The remaining members are displayed 
in the model but are shown without design ratios. 
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6.  Printout 
 

6.1 Printout Report 
Similar to RFEM, the program generates a printout report for the RF-TIMBER SANS results, to 
which you can add graphics and descriptions. The selection in the printout report determines 
what data from the design module will be included in the printout. 

The printout report is described in the RFEM manual. In particular, Chapter 10.1.3.5 Selecting 
Data of Add-on Modules describes how to select input and output data from add-on modules 
for the printout report. 

For complex structural systems with many design cases, it is recommended to split the data 
into several printout reports, thus allowing for a clearly-arranged printout. 

6.2 Graphic Printout 
In RFEM, you can add every picture that is displayed in the work window to the printout report 
or send it directly to a printer. In this way, you can prepare the design ratios displayed on the 
RFEM model for the printout, too. 

Printing of graphics is described in the RFEM manual, Chapter 10.2. 

Designs in the RFEM model 
To print the currently displayed design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure  6.1: Button Print in RFEM toolbar 

Result diagrams 
You can also transfer the Result Diagram on Member to the report or print it directly by using 
the [Print] button. 

 
Figure  6.2: Button Print in the Result Diagram on Member 

The Graphic Printout dialog box appears (see figure on next page). 
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Figure  6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RFEM manual, Chapter 10.2, including the other tabs of this 
dialog box. 

You can move a graphic anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the 
navigator of the printout report. The Properties option in the shortcut menu opens the Graphic 
Printout dialog box, offering various possibilities for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
This chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design: In this way, you can combine groups 
of structural components or analyze members with particular design specifications (for exam-
ple changed materials, load duration or system factors, optimization).  

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a RF-TIMBER SANS design case, you can also use the load case list in the RFEM 
toolbar. 

Create new design case 
To create a new design case, use the RF-TIMBER SANS menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New RF-TIMBER SANS Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the RF-TIMBER SANS Window 1.1 General Data where you can enter the 
design data. 

Rename design case 
To change the description of a design case, use the RF-TIMBER SANS menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename RF-TIMBER SANS Case 

In this dialog box, you can enter a different Description and also a different No. of the design 
case. 



7  General Functions 

 64 Program RF-TIMBER SANS © 2016 Dlubal Software GmbH 

 

Copy design case 
To copy the input data of the current design case, use the RF-TIMBER SANS menu 

File → Copy Case 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy RF-TIMBER SANS-Case 

Define the No. and, if necessary, a Description for the new case. 

Delete design case 
To delete design cases, use the RF-TIMBER SANS menu 

File → Delete Case 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

The design case can be selected in the list Available Cases. To delete the selected case,  
click [OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overloaded or little utilized cross-sections. 
To do this, select in the column D or E of the relevant cross-sections in the 1.3 Cross-Section 
Window the option Yes (for parametric rectangular and circular sections) or From current row 
(for standardized sections according to [1], see Figure 2.19 on page 21). 

You can also start the cross-section optimization in the results windows by using the shortcut 
menu.  

 
Figure 7.5: Shortcut menu for cross-section optimization 

During the optimization process, the module determines the cross-section that fulfills the anal-
ysis requirements in the most optimal way, that is, comes as close as possible to the maximum 
allowable design ratio specified in the Details dialog box (see Figure 3.5, page 44). The required 
cross-section properties are determined with the internal forces from RFEM. If another cross-
section proves to be more favorable, this cross-section is used for the design. Then, the graphic 
in Window 1.3 shows two cross-sections: the original cross-section from RFEM and the opti-
mized one (see Figure 7.7). 

For a parameterized cross-section, the following dialog box appears when you have selected 
Yes from the drop-down list. 

 
Figure 7.6: Dialog box Timber Cross-Sections - Rectangle : Optimize 
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By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimization process. 

If you want to Keep current side proportions, select the corresponding check box. In addition, 
you must select two parameters for optimization. 

Please note that the internal forces are not automatically recalculated with the changed cross-
sections during the optimization: It is up to you to decide which cross-sections should be 
transferred to RFEM for recalculation. As a result of optimized cross-sections, internal forces 
may vary considerably because of the changed stiffnesses in the structural system. Therefore, it 
is recommended to recalculate the internal forces of the modified cross-section data after the 
first optimization, and then to optimize the cross-sections once again. 

You can export the modified cross-sections to RFEM: Go to the 1.3 Cross-Sections Window, and 
then click 

Edit → Export All Cross-Sections to RFEM 

Alternatively, you can use the shortcut menu in Window 1.3 to export optimized cross-sections 
to RFEM. 

 
Figure 7.7: Shortcut menu in Window 1.3 Cross-Sections 

Before the changed materials are transferred to RFEM, a security query appears as to whether 
the RFEM results should be deleted.  

 
Figure 7.8: Query before transfer of modified cross-sections to RFEM 
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By confirming the query and then starting the [Calculation] in the RF-TIMBER SANS module, 
the RFEM internal forces as well as the designs will be determined in one single calculation 
run. 

If the changed cross-sections have not been exported to RFEM yet, you can reimport the origi-
nal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in the 1.3 Cross-Sections Window. 

7.3 Units and Decimal Places 
Units and decimal places for RFEM and the add-on modules are managed in one dialog box.  
To define the units in RF-TIMBER SANS, select menu 

Settings → Units and Decimal Places. 

The following dialog box appears that is familiar from RFEM. RF-TIMBER SANS is preset in the 
Program / Module list. 

 
Figure 7.9: Dialog box Units and Decimal Places 

You can save the settings as a user profile to reuse them in other models. These functions are 
described in the RFEM manual, Chapter 11.1.3.   
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7.4 Data Transfer 

7.4.1 Export Material to RFEM 
If you have modified the materials in RF-TIMBER SANS for design, you can export the modified 
materials to RFEM in a similar way as you export cross-sections: Open the 1.2 Materials Window, 
and then click  

Edit → Export All Materials to RFEM. 

You can also export the modified materials to RFEM using the shortcut menu of Window 1.2. 

 
Figure 7.10: Shortcut menu of Window 1.2 Materials 

Before the changed materials are transferred to RFEM, a security query appears as to whether 
the results of RFEM should be deleted. When you have confirmed the query and then start the 
[Calculation] in RF-TIMBER SANS, the RFEM internal forces and designs are determined in one 
single calculation run. 

If the modified materials have not been exported to RFEM yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.10. Please note, however, 
that this option is only available in the 1.2 Materials Window. 

7.4.2 Export Effective Lengths to RFEM 
If you have adjusted the materials in RF-TIMBER SANS for design, you can export the modified 
materials to RFEM in a similar way as you export cross-sections: Open the 1.7 Effective Lengths - 
Members Window, and then select 

Edit → Export All Effective Lengths to RFEM 

or use the corresponding option on the shortcut menu of Window 1.7. 

 
Figure 7.11: Shortcut menu of Window 1.7 Effective Lengths - Members 

Before the modified materials are transferred to RFEM, a security query appears as to whether 
the results of RFEM should be deleted. 

If the modified effective lengths have not been exported to RFEM yet, you can reimport the 
original effective lengths to the design module by using the options shown in Figure 7.11. 
Please note, however, that this option is only available in the Windows 1.7 Effective Lengths - 
Members and 1.8 Effective Lengths - Sets of Members. 

7.4.3 Export Results 

The RF-TIMBER SANS results can also be used by other programs. 

Clipboard 
To copy selected cells of the results windows to the Clipboard, use the [Ctrl]+[C] keys. To insert 
the cells, for example in a word processing program, press [Ctrl]+[V]. The headers of the table 
columns will not be transferred. 
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Printout Report 
You can print the data of the RF-TIMBER SANS add-on module into the global printout report 
(see Chapter 6.1, page 61) for export. Then, in the printout report, click 

File → Export to RTF 

The function is described in the RFEM manual, Chapter 10.1.11. 

Excel / OpenOffice 
RF-TIMBER SANS provides a function for the direct data export to MS Excel, OpenOffice Calc, or 
the file format CSV. To open the corresponding dialog box, click 

File → Export Tables 

The following export dialog box appears. 

 
Figure 7.12: Dialog box Export - MS Excel 

When you have selected the relevant options, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, that is, the programs do not have to be 
opened first. 

 
Figure 7.13: Results in Excel 



8  Examples 

 70 Program RF-TIMBER SANS © 2016 Dlubal Software GmbH 

 

8.  Examples 
 

8.1 Beam Column (ASD Solution) 

We perform the design according to SANS 10163-2 ASD [2] for wood column that is subjected 
to compression and bending. At its base, it provides a non-movable hinged support. At the 
top, there is a hinged support which is movable along the local x-axis. The column is braced at 
the mid-height in the narrow dimension. The material is a SA Pine 4 and moisture content will 
not exceed 170 g/kg.   

8.1.1 System and Loads 

 
Figure 8.1: System and loads 

Model 
Cross-section:  b = 100 mm 

    d = 220 mm 

Material:   SA Pine 4 

Moisture Content:  ≤ 170 g/kg 

Load 
LC 1 Permanent:  6.0 kN 

LC 2 Wind:  1.6 kN/m 

LC 3 Imposed Load: 8.0 kN 

Load combinations 
ULS:   1.35LC1 + 1.5LC2 + 1.05LC3 

SLS:   LC1 + LC2 + 0.7LC3 
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8.1.2 Calculation with RFEM 
 The system as well as the loads in all load cases is modeled in RFEM as a 3D model. We deacti-
vate the automatic consideration of the self-weight when we create LC1. 

We create the load combinations for ULS and SLS with the relevant factors for the defined load 
cases. Then we calculate the model according to the linear static analysis. 

 
Figure 8.2: Internal forces N, Vz and My (ULS) 

8.1.3 Design with RF-TIMBER SANS 
8.1.3.1 Ultimate Limit State Design 

In window 1.1 General Data, we select combination CO3 for the Ultimate Limit State design. 

 
Figure 8.3: Window 1.1 General Data 
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The 1.2 Materials window presents the grade stresses of the selected material. 

 
Figure 8.4: Window 1.2 Materials 

In the 1.3 Cross-Sections window, the parameters of the cross-section can be checked. 

 
Figure 8.5: Window 1.3 Cross-Sections 
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In window 1.4 Load Duration, we define the load effect and load duration. The load duration 
factor, k1, is determined from the ratio of internal forces at the current location. It may cause 
different values of the factor at each x-location. 

 
Figure 8.6: Window 1.4 Load Duration 

In window 1.5 Moisture Content and Fabrication Quality - Members, we define the moisture con-
tent for ULS and SLS design. In our case the column fabrication does not comply with a SANS 
standard, therefore the fabrication quality factor, k4, is taken as 1.0. 

 
Figure 8.7: Window 1.5 Moisture Content and Fabrication Quality - Members 
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In the 1.7 Effective Lengths - Members window we specify the buckling lengths of the column.  

As far as the main axis is concerned (Buckling About Axis y), we can leave the default value 3.0 m 
(see [1] Table 15). For the minor axis (Buckling About Axis z), however, we can reduce the buck-
ling length to Lez = 1.50 m as the column is restrained in the middle of the member. We can al-
so deactivate Lateral-Torsional Buckling because the slenderness factor CS does not exceed 10 
(see [1] Chapter 7.2.3.2.3 a)). 

 
Figure 8.8: Window 1.7 Effective Lengths - Members 

In window 1.9 Additional Design Parameters - Members, the use of the load sharing factor k2 is 
not required. The structure type of the column is a Beam. 

 
Figure 8.9: Window 1.9 Additional Design Parameters - Members 

Then we start the [Calculation]. 
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Results 
After the calculation, the governing design is presented in the 2.1 Design by Load Case Window. 
All values you need to comprehend the calculation are listed in the lower part of this window. 

 
Figure 8.10: Window 2.1 Design by Load Case 

Load Duration Factor  

The table below shows the internal forces of the load cases, without partial safety factors, that 
are included in combination CO3: 

Loading Load Effect Load Duration Coefficients N [kN] Vz [kN] My [kNm] 

LC1  Self-weight Permanent CfD 1.00 -6.0 0 0 

LC2  Wind Short Term CfW 0.66 0 2.40 1.8 

LC3  Imposed Medium Term CfI 0.80 -8.0 0 0 
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Allowable Shear Stress 
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8.1.3.2 Serviceability Limit State Design 

In the Serviceability Limit State tab of the 1.1 General Data Window, we select the load com-
bination CO8 for design. 

 
Figure 8.11: Window 1.1 General Data, tab Serviceability Limit State 
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Then we enter member No. 1 in the 1.1 Serviceability Data Window.  

 
Figure 8.12: Window 1.11 Serviceability Data 

We do not modify the Reference Length but we restrict the Direction to z (in this case we could 
leave y,z as well). As it is a simple span beam, we select the Beam in the Beam Type list. 

The limiting deflection is L/300 according to the deflection limits in the Details dialog box. 

 
Figure 8.13: Dialog box Details, tab Serviceability 

In this example, we do not consider the deflection due to shear. Therefore, we deactivate the 
shear stiffness in the Calculation Parameters dialog box of RFEM. 

 

Figure 8.14: Dialog box Calculation Parameters in RFEM and deflection of CO8 
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Figure 8.15: Window 2.1 Design by Load Case 
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8.2 Timber Beam (LSD Solution) 
We perform the design according to SANS 10163-1 LSD [1] for timber roof purlin that is re-
strained and subjected to biaxial bending. The beam is laterally supported at this ends only, 
and there are no intermediate lateral supports. The material is a SA Pine 7.  

 

Figure 8.16: System and loads 

Model 

Cross-section: b = 100 mm 

d = 220 mm 

Material:  SA Pine 7 

 

Load 

LC 1 Permanent:  1.3 kN/m 

LC 2 Imposed Load: 2.1 kN/m 

Load combination ULS: 1.35LC1 + 1.5LC3 

8.2.1 Calculation with RFEM 
 The system as well as the loads in all load cases is modeled in RFEM as a 3D model. We deacti-
vate the automatic consideration of the self-weight when we create LC1. 

We create the load combinations for ULS design with the relevant factors for the defined load 
cases. Then we calculate the model according to the linear static analysis. 

RFEM determines the diagrams of internal forces shown in the following figure. 
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Figure 8.17: Internal forces My, Mz, Vz and Vy 
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8.2.2 Design with RF-TIMBER SANS 
8.2.2.1 Ultimate Limit State Design 

In Window 1.1 General Data, we select combination CO4 for the Ultimate Limit State design. 

 
Figure 8.18: Window 1.1 General Data 

The 1.2 Materials Window presents the grade stresses of the selected material. 

 
Figure 8.19: Window 1.2 Materials 
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In the 1.3 Cross-Sections Window, the parameters of the cross-section can be checked. 

 
Figure 8.20: Window 1.3 Cross-Sections 

In Window 1.4 Load Duration, we define the load effect and load duration. The load duration 
factor, Υm1, is determined from the ratio of internal forces at the current location. It may cause 
different values of the factor at each x-location. 

 
Figure 8.21: Window 1.4 Load Duration 
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In window 1.5 Moisture Content and Treatment - Members, we define the moisture content for 
ULS design. In our case the roof purlin is not pressure treated, therefore the treatment factor, 
Υm5, is taken as 1.0. 

 
Figure 8.22: Window 1.5 Moisture Content and Treatment - Members 

In the 1.7 Effective Lengths - Members Window we specify the buckling lengths of the purlin. 
The beam is braced only at the ends. The effective buckling length for lateral-torsional buck-
ling is defined as member length. 

 
Figure 8.23: Window 1.7 Effective Lengths - Members 
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In Window 1.9 Additional Design Parameters - Members, the use of the load sharing factor, Υm2, 
is not required. The structure type of the purlin is a Beam. 

 
Figure 8.24: Window 1.9 Additional Design Parameters - Members 

Then we start the [Calculation]. 
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Results 

After the calculation, the governing design is presented in the 2.1 Design by Load Case Window. 
All values you need to comprehend the calculation are listed in the lower part of this window. 

 
Figure 8.25: Window 2.1 Design by Load Case 

Load Duration Factor 
The table below shows the internal forces of the load cases, without partial safety factors, that 
are included in combination CO4: 

Loading Load Effect Load Duration Coefficients 
My 

[kNm] 
Mz 
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Biaxial bending design 
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